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Introduction 

This section introduces various manuals related to the 
product that you will use. As necessary, use these manuals 
before using the product. 
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1. Related Manuals 
The manuals related to the product are listed below. 

Read them as necessary along with this document. 
  

 Must Read the Followings. 
Name Purpose Contents How to get 

Product Guide Must read this after opening the 

package. 

This lists the product configuration 

and describes the precautions. 

Included in the package 
(Printed matter) 

Setup Manual Read this when setting up the 

product. 

This describes the required items for 

setup and configuration procedure. 
 

Download from 
the Contec 
website (PDF) 

 

Reference Manual 
(Hardware) 

Read this when operating the 

product. 

This describes the hardware aspects 

such as functions and settings. 
 

Download from 
the Contec 
website (PDF) 

 

Reference Manual 
(Software) 

Read this when setting up the 

"CONPROSYS WEB Setting" 

This describes how to set each 

function of "CONPROSYS WEB 

Setting". 

 
Download from 
the Contec 
website (PDF) 

 

 
 

 Download Manuals 
Download the manuals accordingly from the following URL. 

 
Download https://www.contec.com/download/ 
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Overview 

This section explains items, such as the overview and 
preconditions for performing practices using this guide. 
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1. Overview 
This guide explains the methods of actually creating resources on the Microsoft Azure, collecting 
data transmitted from CONPROSYS, processing real-time data, storing data and visualizing data. 

 
 

Product name Role 

CONPROSYS Collect information from the sensors, etc., and transmit the collected 
information to the IoT Hub. 

 
 
 

Microsoft Azure Services 
 

Azure Services Role 

IoT Hub Transmit/receive data between devices (e.g., CONPROSYS) and Azure 

Stream Analytics Process real-time data, convert data and extract features 

Blob Storage Store measurement data 

Power BI Visualize measurement data 
 
 

* This guide shows examples of linkage between CONPROSYS and Azure. 
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2. Preconditions 
Please prepare the following accounts required by this guide in advance. 

 

 Azure Subscription and Microsoft Account 
An activated Azure subscription and a Microsoft account are required. 

 

 CAUTION 
Be sure to purchase and activate an Azure subscription before starting the practices in this guide. 

For the procedures for purchase and activation of a Microsoft Azure subscription, see “Microsoft 
Azure subscription application - Service usage step by step”. 

https://docs.microsoft.com/en-us/azure/architecture/ 
 

 
* For details on the rate structures and rate plans of Microsoft Azure, visit the following website: 

http://azure.microsoft.com/en-us/pricing/overview/ 
 
 

 Account to Access the Power BI Website 
An account to access the Power BI website is required. 

To register (sign up) for the Power BI website, register your “e-mail address”, “password” and “name” 
from the following URL: 
https://powerbi.microsoft.com/en-us/ 

 
You cannot use your personal e-mail address to register an e-mail address here. 

(An e-mail address used in a company/organization must be entered) 
 
 

 CONPROSYS Operating Procedures 
Regarding the procedures for data linkage with Microsoft Azure, the configuration of the basic 
settings of CONPROSYS, task scripting settings and monitoring settings are explained. These 
explanations assume that you understand the operation methods of these settings to some degree. 

For the detailed setting methods, see the “Reference Manual (Software Edition)”. 
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3. Advance Preparation 

1.  Task 1: Installing Microsoft Azure Storage 
Explorer 

1 Install Microsoft Azure Storage Explorer. 
Access the URL (http://storageexplorer.com/) and download Microsoft Azure Storage Explorer. 
Click “Free download for Windows” displayed at the center of the screen. 

 
 

2 Select [Save] for “StorageExplorer.exe”. 

 
 

3 Click the downloaded “StorageExplorer.exe” to install it. 

 
 

4 Select “I accept the agreement”, and then click [Install]. 
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5 Select the installation folder, and then click [Next >]. 

 
 

6 Select the Menu folder, and then click [Next >]. 
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7 The installation starts. 

 
 

8  Click [Next >] to complete the installation. 
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9 Microsoft Azure Storage Explorer starts. 
If you are using a Proxy, be sure to configure the “Proxy Settings”. 

 
 

10 Register a user for Microsoft Azure. 
1. Click the user icon. 

2. Click [Add an account]. 

3. When the Azure login screen is displayed, enter the account information “e-mail address”. 

4. Enter the “password”. 

5. Click [Sign in]. 
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11 After the registration is completed, click the user icon, select the displayed subscription, and 
then click [Apply]. 

 
 

12  The information of storage accounts under the Azure user is displayed. 

 
 
 

This completes the installation of Microsoft Azure Storage Explorer. 
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2.  Task 2: Installing Device Explorer 
Install Device Explorer. 

 

1 Access the URL (https://github.com/Azure/azure-iot-sdks/releases), and then click the installer 
“SetupDeviceExplorer.msi” of Device Explorer to download it. 

 
 

2  Run the downloaded “SetupDeviceExplorer.msi”. 

 
 

3 Start the installation, and then click [Next >]. 
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4 Specify the installation folder, and then click [Next >]. 

 
 

5 The installation is confirmed. Click [Next >]. 
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6 Complete the installation, and then click [Close]. 
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Practices 

This section provides explanations for matters, such as how 
to access Azure and how to transmit data from 
CONPROSYS. 
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1. Details of Practices 
This guides explains the following practice details. 

 
Practice 1: Accessing Azure, and creating a resource group. 

Practice 2: Creating an Azure IoT Hub, and transmitting data from CONPROSYS. 

Practice 3: Checking the received information of Azure IoT Hub using Device Explorer. 
Also, transmitting data from Device Explorer to CONPROSYS. 

Practice 4: Storing the IoT Hub data in BLOB storage using Stream Analytics. 
Also, checking the stored information using Microsoft Azure Storage Explorer. 

Practice 5: Visualizing the IoT Hub data in Power BI using Stream Analytics. 
 
 

You will learn the method of expanding the following system configuration on Azure through the five 
practices. 
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2. Practice 1: Accessing Microsoft Azure 
This practice explains how to access Microsoft Azure and how to create a resource group. 

 

[Reference] Tips for starting the Web browser 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1 Access the Azure Portal (https://portal.azure.com/) using the Web browser, enter the 
Microsoft account and password on the displayed Azure sign-in screen, and then click the 
[Sign in] button to log in to Azure Portal. 

          
 
 

Enter the password here 

Enter the Microsoft account here 

If more than one Microsoft accounts or Azure accounts are used, you may not be able to sign in to 
Azure Portal successfully due to the problems of the browser cache. 

For IE: 
[Settings] - [Safety] - [InPrivate Browsing] 

For Google Chrome: 
[Settings] - [New Incognito Window] 



— Practices — 
Microsoft Azure Data Transmission Procedure 

— 19 — 

2 When you log in, the following Azure Portal screen is displayed. 
(Indication details vary depending on the status of the service you are using.) 

 
 

3 First, create one resource group from the Azure Portal. 
* The resources that you will create in the subsequent tasks are put in this resource group. 
 From the Hub menu, click [Resource groups], and then [Add]. 
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4 Enter the setting items, and create a resource group. 

 
 

 
Setting item Setting details 

Resource group name Enter [CONTEC_DEMOxxx] * Set any name 

Subscription Select [Microsoft Azure] 

Resource group location Select [Japan West] 
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3. Practice 2: Transmitting Data from the 
Device to Azure IoT Hub 

This practice explains how to create an Azure IoT Hub and how to transmit measurement data from 
the device (CONPROSYS) to the IoT Hub. 

1.  Task 1: Creating an Azure IoT Hub 

1 Create one IoT Hub from the Azure Portal. 
From the Hub menu, click [Create a resource], [Internet of Things], and then [IoT Hub]. 
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2 Enter the following setting details in the IoT Hub, and then click the [Review + create] button. 

 
 

 
 

Setting item Setting details 

IoT Hub Name Enter [CONTEC-DEMOxxx] * Set any name 

Price and scale tier S1 - Standard 

Number of S1 IoT Hub units 1 

Device-to-cloud partition 4 partitions 

Subscription Select [Microsoft Azure] 

Resource Group Check “Use existing”, and then select “CONTEC_DEMO”. 

Region Select [Japan West] 
 
 

3 When you click the notification icon, a notification stating “Deployment in progress....” is 
displayed. 
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4 If you wait for a while after the deployment is started, a notification stating that the creation of 
the IoT Hub is completed is displayed. 

 
 

5  From the Hub menu, click [Resource groups], select the resource group you have created, 
and then click [Overview]. You can view the created IoT Hub resources. 
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6 When you select and click the created IoT Hub, the setting screen of the IoT Hub is displayed. 

 
 

7 Then, select [Shared access policies] from the Setting menu, and then click [iothubowner]. 
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8 Copy and make a note of the value of [Connection string-primary key] from [Shared access 
keys]. 
(Click the copy icon on the right to save it to the clipboard) 
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2.  Task 2: Registering the Device (CONPROSYS) in 
IoT Hub 

1 Using the Device Explorer tool, register the device (CONPROSYS) so that it can access the IoT 
Hub you have created. First, select [All apps] from the Start menu, click [Azure IoT Hub] and 
[Device Explorer], and then start the Device Explorer tool. 

 
 

2  After the Device Explorer tool is started, paste the [Connection string-primary key], which you 
copied in Task 1 of Practice 2, into [IoT Hub Connection String] under the [Configuration] tab, 
and then click the [Update] button. 

 
 

3 After a while, a message saying, “Settings updated successfully” is displayed. Click the [OK] 
button. 
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4  Open the [Management] tab, and then click the [Create] button. 

 
 

5  Enter any value in [Device ID], and then click the [Create] button. 
* Use the automatically generated values for [Primary Key] and [Secondary Key]. 

 
 

6 When “Device Created” is displayed, click the [Done] button. 
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7 Select and right-click the device you have created, and then click [Copy connection string for 
selected device]. 
* Make a note of the connection string you copied here because it will be used in the 
subsequent procedure. 

 
 
 
 

 
 
The Device Explorer tool performs various functions of IoT Hub, such as adding devices, using the 
Azure IoT service library. When you add a device using Device Explorer, the corresponding 
connection string is displayed. 
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3.  Task 3: Transmitting Measurement Data from the 
Device (CONPROSYS) to Azure IoT Hub 

 Preparation of CONPROSYS 
Configure the following settings according to your environment so that you can transmit data from 
CONPROSYS to the Azure IoT Hub on the Internet. (For details, see the “Reference Manual (Software 
Edition)”.) 

 

1 Azure IoT Hub transmission/reception settings 
 Click [Menu]→[Setting]→[Azure IoT Hub] to open the setting screen. 
 Paste the “device connection string”, which you copied from Device Explorer in Task 2, into 

[CONNECTION_STRING], and then click the [Set] button. 

 
 

* After setting, execute [Menu]→[Exit]→[Save and Reboot].  
 
 

2 Creating Azure IoT transmission processing task 
Data transmission from CONPROSYS to the Azure IoT Hub is performed with task scripting at 
any timing. The following are the examples (procedures) of task scripting of data transmission 
to the Azure IoT Hub. 

 
 When you click [Menu]→[Task Edit], the task editing screen is displayed. 

 

    
 

■Task editing screen 
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Transmission Task Scripting Examples 
 Create the file to be transmitted using “Log” and “Log String” parts of the processing task. 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create the task scripts described above, and perform [File]→[Save task…]. 

Before restarting and shutting down CONPROSYS, save the settings by executing 
[Menu]→[Exit]→[Save] or [Save and Reboot].  

 
 

The following explains the details of each task process. 

(1) Execute once every minute. * In the example, the process goes to the subsequent step at 00 
seconds every minute. 

 

①  

②  

③  

④  

⑤  

⑥  

⑦  

⑧  

⑨  

■Explanation of This Task Scripting 

・Execute the processing once every minute (1) 

・Create a CSV file in File00 (2 to 7) 

・Transmit File00 (8) 

・Delete File00 (9) 

 
 Details of the created CVS file 
      DateTime , TAG00 ,  
      YYYYMMDDHHMMSS , ### ,  
       
    ### : Value of TAG00 
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(2) Write the key character string “DateTime” to File00 (CSV file). 

 
 

(3) Write the key character string “TAG00” to File00 (CSV file). 

 
 

(4) Write CR+LF (line feed code) to File00. 

 
 

(5) Write the date data, which is the value, to File00. 

 
 

(6) Write the value of TAG00 to File00. 
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(7) Write CR+LF (line feed code) to File00. 

 
 

(8) Convert the details of File00 into JSON format, and transmit them to the Azure IoT Hub. 

 
 

(9) Delete the transmitted File00 (CSV file). 

 
 
 
                                      

 

3 Assigning Transmitted Data 
In the task scripting examples stated previously, the method of transmitting the value of 
“TAG00” was described. 
The original purpose of CONPROSYS is to transmit information, such as input information, 
judgment information and information acquired from PLCs. However, we will change the 
transmitted data (TAG00) using the Monitoring (HMI) function to simplify the operation check. 
 
The following explains the method of changing the value of “TAG00” using the Monitoring 
(HMI) function. 

 
 When you click [Menu]→[Monitoring Edit], the monitoring editing screen is displayed. 
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 Add the display parts to the monitoring screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Set the display parts parameters. 
You can set them in the parameter window on the right by selecting each display part. 
Configure the following link settings.  Click the   button to configure the link settings. 
Open the device tree to configure the settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 To save the page: Select [File]→[Save page as]. 
 Please overwrite/save it to “user¥Page1.page”. (“user¥Page1.page” is the initial startup page.) 

                
 

・ Drag the parts from the tree on the left to position. 

   Add the parts as shown in the figure below. 
 
 
 
 
 
 
 
・ Add two pieces of “Slider” and “Label”. 

Set the link to “TAG00.” 
Set the IO to “out”. 

 

Set the link to “TAG00.” 
Set the IO to “in”. 

 

Set the link to “TAG01.” 
Set the IO to “in”. 
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 Confirm that the “TAG00” variable can be changed. 
Click [Menu]→[Monitoring View]. The screen you created above is displayed. 

              

* Please check the changes in the “TAG00” value according to the changes in the slider. 
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4. Practice 3: Checking the Azure IoT Hub 
Communication Status 

In this practice, we will check the communication status between the Azure IoT Hub and CONPROSYS 
using “Device Explorer”. 

 

1.  Task 1: Checking the Data Reception Status (Data 
Transmission from CONPROSYS) with Device 
Explorer 

 

1 Starting Device Explorer 
Select [All apps] from the Start menu, click [Azure IoT Hub] and [Device Explorer], and then 
start the Device Explorer tool. 

 
 

* If the Device Explorer tool started in Task 2 of Practice 2 is still running, please continue to use it as 
is. 

 

2 Viewing the received data 
Select the [Data] tab, and then click the [Monitor] button. 
* The status set in Task 2 of Practice 2 is assumed to remain. 

 

You can view the information transmitted from CONPROSYS in the “Event Hub Data” section. 
Click the [Cancel] button to stop the monitoring status. 
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Viewing CONPROSYS Transmitted Log 
Click [Menu]→[Status]→[Log] to view the log at the time of execution of the final transmission to the 
Azure IoT Hub in “Azure log”. 

 
 

When successfully transmitted, “!SENDACK:OK” is displayed. 
 

Viewing Resend Files 
When the transmission fails, you can view the resend files by clicking [Menu]→[Status]→[File View], 
selecting [Resend Folder (Azure)], and then clicking the [Get] button. The resend files are stored as 
converted transmitted data (JSON format). 
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2.  Task 2: Checking Data Transmission from the 
Azure IoT Hub 

1 Send a message from “Azure IoT Hub” to CONPROSYS using “Device Explorer”. 
With CONPROSYS, TAG variables can be written by sending a message as shown in the 
example below. 

 

Message Operation Methods 
 Display the [Message to Device] tab in “Device Explorer”. 
  Select the device that you want to check the operation in [Device ID:], and write the data in 

“Message:”. 
 Click the [Send] device button to send data to the device. 

 

When you write the following data in “Message:”, 1 is assigned for the 
value of TAG01. 
{"TAG01":"1"} 

      
 

 

You can view the changes in TAG01 value on the monitoring screen you created in Task 3 of Practice 
2. 

* The message is sent from “Azure IoT Hub” at the time when the data is received from the device. 
In this practice, the message is received and applied at the time when the data is sent from 
CONPROSYS at one-minute cycle. 
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5. Practice 4: Storing the Data in Azure 
Storage 

This practice explains how to store the measurement data received by the IoT Hub in the storage 
using Microsoft Azure Stream Analytics. 

 

1.  Task 1: Creating an Azure Storage Account 

1 From the Hub menu, click [Create a resource], [Storage], and then [Storage account]. 

 
 

2 Enter the name of your storage account, and specify [Resource manager] for the deployment 
model to use. 

 
 
 

The length of the storage account name is from 3 to 24 characters, and only numbers and 
lowercase letters can be used. The storage account name must be a single name within Azure. The 
Azure Portal indicates whether or not the selected storage account name has already been used. 

 
 

Enter any storage account name. 
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3 Select [general purpose] for the storage account type, and specify [Standard] for the default 
for “Performance”. Select [Locally-redundant storage (LRS)] for “Replication”. Select 
[Disabled] for “Storage service encryption (blobs and files)” and “Secure transfer required”. 

 
 

4 Select a subscription for which you want to create a new storage account, select [Use existing] 
for “Resource group” and then select the resource group name you created. Select the 
geographical location of the storage account. Click [Create] to create a storage account. 

 
 

Select “LRS” from the list. 

If there are more than one subscriptions, select 
the Azure subscription for which the account is 
created. 

Select “Use existing”, and then select the 
“Resource group name” you created. 

Select “Japan West” from the list. 
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5 After a while, a notification stating that the creation is completed is displayed. 

 
 

6 From the Hub menu, select [Resource groups], click the resource group name you created in 
Practice 1 from the list of default resource groups, confirm that a new storage account has 
been created, and then click Storage account. 

 
 

7 Click [Overview] under Storage account, and then click [Blobs] under Services. 
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8 Click [Container] to add a container. 

 
 

9 Under New container, enter any value for [Name], and then select [Private] for [Public access 
level]. 
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10 You can view the container you created in the list of Blob service. 

 
 
 

Select the storage account you created, and then click [Access keys]. Copy and make notes of the 
“Storage account name” and “key1”. (Click the copy icon on the right to save it to the clipboard) 
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2.  Task 2: Storing the Data in BLOB Storage Using 
Azure Stream Analysis 

1 In the Azure Portal, click [   ]*New, [Internet of Things], and then [Stream Analytics job]. 

 
 

2 After specifying the following values, click [Create]. 

 
 

Enter any Job name. 

Select “Use existing”. 

Select the Subscription to use. 

Select “Japan West”. 
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3 After a while, a notification stating that the creation is completed is displayed. 

 
 

4  Click [Resource groups] to display the list of resource groups. Select the resource group name 
you created in Practice 1. 

 
 

5 When the list of resource group items is displayed, select the Stream Analytics you created. 

 
 

Select the resource group name you created in Practice 1. 

Select the Stream Analytics job you created. 
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6 Stream Analytics setting/management screen is displayed. Before starting a job, it is necessary 
to configure input/output to the job and queries, etc. Click [Inputs] tile under Job Topology. 

 
 

7 On the displayed [Inputs] item screen, click the [+Add stream input] button on the upper 
left, and then select [IoT Hub] to add an input item. 

 
 

 
 

Click Inputs tile. 



— Practices — 
Microsoft Azure Data Transmission Procedure 

— 46 — 

8 When the new input setting dialog box is displayed, enter the following setting details, and 
then click the [Save] button. 

 
 

9 If you wait for a while after the input test is started, a notification stating that the creation is 
completed is displayed. 

 
 

Enter the alias. Example: input 

Select “IoT Hub”. 

Select the IoT Hub you created in Task 1 
of Practice 2 

Select “Messaging”. 

Select “iothubowner”. 

Select “JSON” format. 

Input test in progress. 

Click [Save]. 

Select Microsoft Azure. 
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10 In the input list, the newly created input is listed. 

 
 

11 Stream Analytics setting/management screen is displayed. Click [Outputs] tile under Job 
Topology. 

 
 

12 On the displayed [Outputs] item screen, click the [+Add] button on the upper left, and then 
select [Blob storage] to add an output item. 

 
 

 
 

Added. 
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13 When the new output setting dialog box is displayed, enter the following setting details, and 
then click the [Save] button. 

 
 
 

Enter the alias. Example: output 

Select “Blob storage”. 

Select the storage account you created in Task 1 of 
Practice 3. If the storage account is not displayed, see 
the supplement on the following page. 

Select the container you created in Task 1 of Practice 3. 

The file path used to locate your blobs within the 
specified container. Within the path, you may 
choose to specify one or more instances of the 
following 2 variables: {date} {time} Example 1: 
cluster1/logs/{date}/{time} Example 2: 
cluster1/logs/{date} 

Select “UTF-8”. 
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* <Supplement> If the storage account cannot be loaded automatically, select [Provide Blob 
storage settings manually], and then enter the “Storage account name” and “Storage account key” 
you have copied in advance. 

 
 

 
 

14 After a while, a notification stating that the connection test has succeeded is displayed.  

 
 

15 In the output list, the newly created “output” is listed. 

 
 

16 Then, click [Edit query] under Job Topology. 
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17 Edit the details of the query. Stream Analytics supports the simple declarative query model, 
which describes conversions for real-time processing. To archive all events, add the following 
details to the code editor. 

 
 

18 Click the [Save] button, and then [Yes]. 

 
 

19 After a while, a notification stating that the setting has been saved is displayed. 

 
 

20 On the Stream Analytics setting/management screen, click [Start]. 

 
 

SELECT 
* 

INTO 
   [output] 
FROM 
   [input] 
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21 When the Start job screen is displayed, select “Now” for Job output start time, and then click 
the [Start] button. 

 
 

22 A notification stating that it is starting the streaming job is displayed, and the streaming job 
status is “Starting”. 

 
 

 
 

23 After a while, a notification stating that the streaming job has been started successfully is 
displayed, and the status will be “Running”. 

 
 

 
 
 
 

The status is “Starting”. 

The status is “Starting”. 
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3.  Task 3: Checking After the Data is Stored 
Access the data stored in Blob storage using the Microsoft Azure Storage Explorer tool. 

 

1 Start the Microsoft Azure Storage Explorer tool, and connect to the Azure account. 
* This operation is unnecessary if already connected. 

 
 

 
 

 
 

 

Click the account icon. 

Click “Add an account”. 

Click “Add an Azure Account”. 

Click “Sign in.” 
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2 On the Microsoft Azure Storage Explorer management screen, click the container name you 
created in Task 1 of Practice 3 from the list of Blob Containers to confirm that the file in CSV 
format has been stored. 

 
 

Add the account information, and then 
click Sign in. 

Check the boxes, and then click “Apply”.  

The Storage Account that you have created is displayed. 

You can confirm that the file in CSV format has been stored. 
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3 Click [Download] to download the file. 
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6. Practice 5: Visualizing the Data in 
Power BI 

 CAUTION 
In Practice 5, we will use the resources developed in Practices 1 to 3. It is necessary to complete 
Practices 1 to 3 before starting Practice 5. 
 

1.  Task 1: Accessing Power BI Portal 

1 Access Power BI Portal (https://powerbi.microsoft.com/en-us/) using the Web browser, and 
then click [Sign in] on the upper right. 

 
 

2 Enter the Power BI account and password on the sign-in screen, and then click the [Sign in] 
button to log in to Power BI. 

          
 

3 After logging in to Power BI, the following screen is displayed. 

 
 

Enter the password here 

Enter the Power BI account here 



— Practices — 
Microsoft Azure Data Transmission Procedure 

— 56 — 

2.  Task 2: Transmitting Data to Power BI 

1 Reopen the Stream Analytics setting screen you created in Task 2 of Practice 3. Click [Resource 
groups], select the resource group name you created in Practice 1 from the list of resource 
groups, and then click the Stream Analytics you created. 

 
 

2 Click the [Stop] button, and then [Yes] to confirm it. 

 
 

3 After a while, the status changes to Stopped. 

 
 

4 After stopped, click [Outputs] tile under Job Topology. 
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5 On the Outputs screen, click [+Add], and then select [Power BI]. 

 

6 When the New output screen is displayed, enter the item [Output alias], and then click 
[Authorize]. 

 
 

Enter the Output alias. Example: outputtopowerbi 
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7 When the Microsoft Azure login screen is displayed, enter the account information to log in to 
Power BI, and then click [Sign in]. 

        
 

8 After login succeeded, the following screen is displayed. Select “My workspace” for [Group 
workspace], and then enter [Dataset name] and [Table name]. After entering, click [Save]. 

      
 

Enter the password. 

Enter the e-mail address. 

Select “My workspace”. 

Enter the Dataset name (CONTEC_DEMO). 

Enter the Table name (CONTEC_DEMO). 
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9 The Output test starts. After a while, a notification stating that the newly created output 
“outputpowerbi” has been added successfully is displayed. 

 
 

10 You can confirm that [outputpowerbi] has been added in the Output list. 

 
 

11 On the Stream Analytics management screen, click [Edit query]. 
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12 Add the following query. 
 

 

     
 

* The data transmitted from CONPROSYS is handled as character string data in Azure. 

Therefore, the data format needs to be changed in order to handle it as numeric data. 

The “CAST” statement is used to change the data format. 
 
 

13 On the Query setting screen, click the [Save] button. When a message saying “The changes 
you made will be saved” is displayed, select [Yes]. 

 
 

14 After a while, a notification stating that the change in the query has been saved successfully is 
displayed. 

 
 

SELECT 
    Datetime, 
    CAST(TAG00 AS BIGINT) AS TAG00 
INTO 
    [outputpowerbi] 
FROM 
    [input] 
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15 To start the Stream Analytics that has been “Stopped”, click [>Start]. 

 
 

16 Select “Now” for Job output start time, and then click [Start]. 

 
 



— Practices — 
Microsoft Azure Data Transmission Procedure 

— 62 — 

17  The status of Stream Analytics is “Starting”. After a while, a notification stating that the 
streaming job has been started successfully is displayed. 

 

18 The status is “Running”. 
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3.  Task 3: Displaying the Data in Power BI 

1 Select [DATASETS] on the lower left of the Power BI Web screen to confirm that the dataset 
name you created earlier has been added in the list. (The dataset name you created in Task 2 
of Practice 4) 

2 Then, click the dataset name to move to the report creation screen. 

 

3 When you click the “Polygonal line” icon in the visualizations list, a line graph is displayed on 
the operation screen. 
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4 When the table is displayed under Fields, select the items “Datetime” and “TAG00”. 

 
 

5 In the line graph, “TAG00” is displayed with “Time” on the horizontal axis. 

 
 

6 Operate the slider of “TAG00” on the CONPROSYS Monitoring screen. After that, you can 
confirm that the change in “TAG00” has been applied in Power BI. 
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7 Click [File] - [Save]. 

 
 

8 Enter the report name, and then click the [Save] button. 

 
 

9 The saved reports are listed under Reports of the Menu. 

 
 

 

 CAUTION 
After the transmission is completed, click [Stop Device] from the “Main” tab of the simulator. 
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Customer Support and 
Inquiry 

CONTEC provides the following support services for you to 
use CONTEC products more efficiently and comfortably. 
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1. Services 
CONTEC offers the useful information including product manuals that can be downloaded through 
the Contec website. 

 
 

Download 
https://www.contec.com/download/ 

You can download updated driver software, firmware, and differential 
manuals in several languages. Membership registration (myCONTEC) 
is required to use the services. 
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